
Introduction to the use of SMath Studio 
Prepared by Gilberto E. Urroz, May 2010

Where to find SMath Studio?
SMath Studio 0.88 is freeware that produces notebook type of mathematical calculations.
You can download SMath Studio at this web site:

http://en.smath.info/forum/default.aspx?g=posts&t=425

Getting started
You will find the icon for  SMath Studio  in the folder  SMath\SMath Studio  under your
Program Files folder  in  your  Windows machine,  or  under  your  Program Files  (x86)
folder  if  you  have  a  64-bit version  of  Windows.   The  program  is  called
SMathStudio_Desktop.exe.  You may want to create a shortcut to the program to place in
your desktop or in your  Quick Launch.   Double click on the program icon or on the
shortcut to open the SMath Studio interface.

The SMath Studio interface
To get started, find the SMath
Studio Desktop  icon in your
Start>Programs button in
Windows.  The SMath Studio
interface is shown here.

The interface shows a main
window with menus, a toolbar,
and a number of palettes on the
right-hand side of the interface.
The palettes contain
mathematical, graphical, and
programming functions that can
be placed in the main window
with the purpose of calculating
mathematical expression,
producing graphs, or building
small programs.  

The SMath Studio menus
The SMath Studio interface
contains menus entitled File,
Edit, View, Insert, Calculation,
Tools, Pages, and Help.  Besides these 8 menus, there is also a menu indicated by a page
icon located to the left of the menu bar.  We'll refer to this menu as the Control menu.
Explore the different menus to become acquainted with the various options available in
them.   The operation of the Control, File, and Edit menus is very similar to those of
other Windows applications, hence, the item therein contained would be familiar to
Windows users.  Other menus are presented below.
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The   Help   menu  
The Help menu contains the option Reference book… which represents a modest attempt
by the author to address basic mathematical operations and definitions.  The contents of
the Reference book are shown in the figure below.  To find the contents of a particular
section of the Reference book, click on that section.  For example, to see the contents of
the section entitled Identical Transformations, click on the corresponding link to produce
the screen in the middle.  If you click on the link entitled Properties of arithmetic roots,
you get the screen shown to the right in the figure below.  This provides some basic
properties of limits that can be useful to review those concepts from algebra. 

You can go back one page in the Reference book by pressing the option Back, or return to
the Contents page by pressing the option Home.  The menu option Copy lets you copy
equations from the Reference book that you can then paste in the main interface.  To copy
a specific equation, first highlight the equation you want to copy, then press Copy, and
paste the equation (using, for example, Cntl-v) onto the main screen.
The Help menu also contains the option Examples, which opens the following menu of
examples:

Click on a given example to select it, and press the [ Open ] button.   The worksheet
corresponding to the example Numeric integration method (Simpson's rule) is shown
below.
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The   Pages   menu  
The Pages menu shows the pages (worksheets) currently
open.  After having opened the worksheet for the
example shown above, the Pages menu will show two
pages open, namely, Page1,the default page open when
we started SMath Studio, and Simpson.sm, the worksheet
we just opened from the Examples menu.
The Pages menu also shows the options New page and Close page, whose operation is
obvious.

The   Tools   menu  
The Tools menu has two items (Options... and Plugins...).  The Options... item opens the
following dialogue form with two tabs as shown below.  
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The Calculation tab in the Options interface lets you modify basic settings for
mathematical calculations, whereas the Interface option deals with properties of the
interface window.  Click on the different drop-down menus to select the setting you
would like to change.  

The Plugins item in the Tools menu produces the following interface:

SMath Studio 0.88 includes the three plugins shown above, namely:

• HTML Export: allows to save files to HTML format
• Special Functions:  handles a number of functions.  Scroll down the cursor to the

right to see all functions available.  A brief description of the functions is
included.

• XMCD Files: allows to save and open XMCD files.  This format is used by the
commercial software Mathcad.

The   Insert   menu  
The Insert menu allows inserting a variety of items into the worksheet (or page), as
indicated in the figure below:
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When you select the option Matrix.. , for example, it produces an entry form that allows
you build a matrix of a pre-determined size:

The option Function… opens up a menu of mathematical functions, i.e., 

Selecting the option Operator… in the Insert menu produces a list of Boolean, arithmetic,
and other operators, e.g., 
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The option Unit... allows inserting units in calculations.  The input form for Units... is
shown below, highlighting the listing of units of Force.  The listing shows the name of
the unit (e.g., Micronewton) and the symbol used for its representation (e.g., N).

The option Text region  in the Insert menu allows the user to insert text fields in the
worksheet with the purpose of documentation.  This is equivalent to pressing the double
quote (") after clicking in any position in the worksheet.  For example:

Inserting a Separator simply means inserting a horizontal line to separate regions in the
worksheet, e.g., 

The insertion of plots and pictures will be illustrated in other sections of this document.

The   View   menu  
The View menu includes an option for activating of deactivating a grid in the main screen
(Grid).  Here is the same worksheet with and without a grid:
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The View menu also includes the option Dynamic Assistance that activates or deactivates
that particular option.  When the Dynamic Assistance  is active, every time that you type
a letter in the main screen, a drop down menu of functions starting with that particular
letter becomes available.  You can then scroll down and select a particular function.  For
example, if you type  the letter d the following dynamic assistance menu becomes
available:

The drop-down menu shows functions day (a unit, described in the box to the right in
terms of the unit s, or seconds), deg (a unit, degrees), det (determinant of a matrix), dfile
(delete file), diag (create a diagonal matrix out of a vector), etc.  Scrolling the cursor to
the right, up or down, will provide additional function or unit definitions.

The   Calculation   menu  
The Calculation menu offer options useful when calculating symbolic or numeric
expressions.  Unless a particular calculation has been selected, these options show as
inactive (shadow options) in the menu, e.g., 

The only active options shown above are Auto calculation and Recalculate page.  The
meaning of these, and the other options shown above, is obvious.

To illustrate the use of some of the other items in the Calculation menu, click
somewhere in the main screen and enter the expression 5+7/3.  Then, click on 
the expression, and drag the cursor over the expression to highlight it.  The
highlighted expression should look as shown in the figure to the right. 
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Click on the Calculation menu and select, for example the Calculate option.  This
produces the result 22/3.  Try using the other available options such as Simplify, and
Invert.  

To check the use of the option Determinant first you need to enter a matrix in the main
screen.  Click somewhere in the main screen, and use the option Insert > Matrix, and
change the number of rows and columns to 2, i.e., 

This results in the expression:

Click on each of the place holders, one at a time, and enter the values 2, 5, 3, and 1, so
that the resulting matrix is:

Click somewhere inside the matrix, and drag the cursor over the matrix to highlight it:

Next, click on the Calculation menu and select the Determinant option.  The result is the
value -13, which is the determinant of the matrix shown above, namely, 21 – 53 = -13.

Note: I'm not familiar with the use of the options Solve and Differentiate in the
Calculation menu.  Therefore, I am not including any examples of those options.
Examples of the function solve and of derivatives in SMath Studio are presented later in
this document.
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The SMath Studio toolbar
The SMath Studio toolbar contains 19 icons briefly described below:

1. New page
2. Open (existing worksheet)
3. Save (current worksheet)
4. Print (current worksheet)
5. Cut
6. Copy
7. Paste
8. Undo (recent action)
9. Redo (recent action)
10. Font size
11. Text color

12. Background color
13. Control border (frames selection)
14. Align horizontally
15. Align vertically
16. Function (insert a function)
17. Unit (insert unit)
18. Reference book (see Help)
19. Recalculate page
20. Interrupt process
21. Show/hide side panel

Items (1) through (4) manipulate new or existing worksheets.  Items (5) through (7) are
well-known editing functions.  Items (8) and (9) will un-do and re-do the most recent
action.  Items (10) through (12) adjust font or background properties.  Item (13) allows
you to put a frame over an entry, for example, to show a solution to a problem.  Items
(14) and (15) re-align selected cells.  Item (16) and (17) open the Function and Unit
menus, as shown earlier under the Insert menu.  Item (18) is also available under the
Help menu. Items (19) and (20) were shown earlier in the Calculation menu.  Item (19)
shows or hides the palettes on the right-hand side of the page.  

Using SMath Studio as a calculator
SMath Studio (or, simply, SMath) can be used as a calculator.  For example, open a new
page, and click on the main window in an area near the top left corner.  A small red cross
will indicate the location where you want to enter a calculation. Type the following:

1+2/3+4/5 =

The result is the following expression:

Notice the way that SMath interprets the two fractions.   Try the following example also:
click somewhere else in your worksheet and type:

5 + 2/3 []+ (4/5) =
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The result is now:

Suppose that you want to calculate the expression 
23

4
.  Use the following

keystrokes:
2 + 3 [space] 4 = 

Here [space] means to press the space bar.   The result is: 

The figure above shows the result immediately after entering the equal sign (=).  If you
click somewhere else in the worksheet, then the result of this operation is shown as:

More complex expressions can be built using the palette functions shown on the right-
hand side of the screen, for example:

Expressions such as the one shown above can be edited by clicking on the location where
the editing is to be done, and then entering factors or functions.  For example, to modify
the expression above, we could click on the right side of the 3 within the square root in
the numerator, i.e.,  

and type * 3 [space]  4.  Then, select the 1 within the exp function in the denominator
and type over the expression exp(1.2).  The modified expression will be the following:
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Functions in SMath
Calculations in SMath may involve mathematical functions such as sin, cos, exp, etc.
You can insert any function by using the menu option Insert > Function… or by pressing
item (15) [f(x)] in the toolbar.  As indicated earlier, collections of functions under the
headings All, Matrix and vector, Complex numbers, Trigonometric, Hyperbolic, and
Programming are available.   The figure below shows the options for complex number
functions:

In this example, function arg is selected.  The argument (arg) of a complex number is the
angle that a vector representing the complex number in the complex plane forms with the
real (x) axis.  As indicated in the figure above, as you select a particular function the
Insert – Function form provides an Example as well as a brief Description of the
function.  

Typically, you will start an expression in the worksheet and, at the proper location, insert
the function that you need.   For example, calculate the expression that uses the
hyperbolic function asinh:

Some functions are available for insertion in the Functions
palette shown to the right: → → → → → → → → → → → →

To enter any of those functions simply place a cursor in the desired position and click on
the name of the function, e.g., type:
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Some of the functions in the Functions palette include operations typical from Calculus,
such as summation, products, derivatives, and integrals, e.g.,

In these expressions we used symbols that are available in the Functions palette as well
as other symbols available in the Arithmetic palette: Infinity (∞), Symbolic evaluation
() , and  (the ratio of the length of the circumference to the diameter of a circle).

Numeric versus symbolic evaluation
An expression that results in a number is evaluated using the numerical evaluation
symbol (=), whereas, an expression that results in a symbolic output needs the symbolic
evaluation symbol ().   Both symbols are available in the Arithmetic palette.  The
numerical evaluation symbol (=) can be typed directly from the keyboard (it's just the
equal sign).  The symbolic evaluation symbol () can also be entered by typing
Ctrl+period (Ctrl+.).

The examples above show the summation and product producing numeric results, while
the derivative and the definite integral produce symbolic results.  Notice the difference
between numeric and symbolic results in the following integral:

In the current version of SMath Studio, the main difference between numeric and
symbolic results is whether a result is shown in its decimal form (numeric) or as a
fraction (symbolic) and other symbolic results such as square roots, etc.  A proper
symbolic result in the integral above would have been the expression ln(3), however,
SMath Studio does not handle such type of symbolic calculations when the result
involves a function definition. 

For an open-source, free program that would handle such type of symbolic calculations
please refer to this web site: http://www.neng.usu.edu/cee/faculty/gurro/Maxima.html.

Note: Use function eval to convert from symbolic to numeric results, e.g., eval(sqrt(3)).
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An alternative for entering functions in expressions is simply to type the name of the
function.   For example, click in another area of the main SMath Studio interface, and
type the following expression:

2.5*sin(2.5)+1.2*cos(2+3/(1+4*1.2^2))

The results of this operation will be shown as:

The Insert - Function menu in SMath Studio
As indicated earlier, the Insert - Function menu in SMath Studio can be obtained by
pressing the [f(x)] button in the tool bar.  This menu includes function groups labeled All,
Matrix and vector, Complex numbers, Trigonometric, Hyperbolic, Programming, Strings,
and Files.  

• The Complex numbers, Trigonometric, Hyperbolic, and Programming function
groups include a relatively small number of easily recognizable functions.  

• The Matrix and vector group includes a total of 30 functions useful for the
manipulation of and calculations with vectors and matrices.  

• The Strings group includes functions used in manipulating and operations with
strings.  These can be useful in programming.  

• The Files group includes functions for reading, writing, and deleting files, as well
as for importing data into a worksheet.  

As indicated before, examples and brief explanations of the functions are available in the
Insert-Function menu.  

The All menu includes all existing functions in SMath Studio.  Herein we group some of
those functions according to their applications:

 Functions specific to SMath Studio: eval, range, sys, error, 
 Functions for real numbers:  abs, exp, Gamma, ln, log, log10, mod, nthroot,

numden, perc, round, sign, sqrt
 Functions for algebraic manipulation: expand
 Functions for solving equations: polyroots, solve
 Functions for Calculus applications: diff, int, product, sum 
 Functions for interpolation: ainterp, cinterp, linterp
 Statistics functions: random
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Entering Greek letter in SMath Studio
Greek characters can be entered by using the Symbols palettes
in the interface.  These palettes, showing lower-case and
upper-case Greek letters, are shown in the figure to the right.

An alternative way to enter Greek letters is to type a letter in
the English alphabet followed by Ctrl-g.  This will generate a
corresponding Greek letter.  For example, typing g Ctrl-g
produces the Greek letter  (gamma).  The corresponding
upper case character would be entered as G Ctrl-g, resulting in
the letter  (upper-case gamma).  

The table below shows the letters of the Greek alphabet and its closest equivalent English
letters.

Clicking on any of the letters in the Symbols palette will copy that letter to any entry
point or text in the worksheet.  To illustrate this fact we perform symbolic and numeric
calculations with trigonometric functions that features the value :

Notice that SMath Studio assigns the proper value to the symbol in the calculation.

Defining variables in SMath Studio
To define a variable in SMath Studio use the assignment operator (:=).  To enter this
operator simply press the colon key in your keyboard (:).  Click anywhere in the
worksheet and make the following variable assignment:  x := 2, by typing: x : 2.  The
value of 2 is now stored in the name x.  The value x = 2 will be replaced into any
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expression containing the name x that is located below or to the right of the assignment
statement.  To check this fact, type an equal sign in a location above the assignment
statement x:=2 and fill the placeholder to the left with the expression x2-3.  The result is
inconclusive, as shown below.   Then, repeat this operation in a location below or to the
right of the assignment statement x:=2.  The result now is 5, as illustrated below.

Once you have made variable assignments, you can use the assigned variables to
calculate expressions.  As an example, assign the values x: =-2 and y:=3, then calculate
the following expression: x2+y2.  The result may look somewhat like this:

The following example shows variable assignments that use Greek letters:

The keystrokes used to produce these entries are the following:  

<click>  f Cntl-g : 1.25   <click>   y  Cntl-g : 2.35   
<click>  g Cntl-g : 2.22   
<click>  D Cntl-g : sqrt f Cntl-g ^ 2 + y Cntl-g ^ 2 + g Cntl-g ^ 2
<click>  D Cntl-g  =

The symbol <click> indicates that the user must click somewhere in the worksheet.

Using units
Units are important in calculations in the physical sciences.  Units in SMath Studio can be
incorporated by using the Unit button in the toolbar (see item (17) in page 9).  For
example, to enter the quantity 25 hp (25 horsepower), click somewhere in the worksheets,
type 25 and the click on the Unit button in the toolbar.   Scroll down to find the unit
category Power, and select the unit horsepower ('hp), as shown below.

page 15               © Gilberto E. Urroz, May 2010



Press [Insert] to obtain the following result:

If you next press the equal sign, the quantity entered will be expressed using the basic
units of the SI (Systeme International, or International System of units), e.g., 

Notice that the units are shown in blue italics font.  This way the symbol m is different
than the symbol m in your worksheet, so you can use m for meters and m for mass, for
example. 

Explore the units menu to see all the available unit categories (Angle, Area, Capacitance,
…, 
Volume), and the available units.  For example, for Angle, you have available the units
Degree('o), Degree ('deg), Radian ('rad), and Revolution ('rev).  

Entering units without the Unit menu
An alternative way to enter units is to type the single quote, or apostrophe, symbol (')
followed by the unit symbol.  This approach requires that you know the proper symbols
to enter.  If the option View>Dynamic Assistance is active, you will get a menu of
possible functions and units to insert.  If you are not sure of the symbol for the units to
insert use the approach shown earlier utilizing the full units menu.  Here is an example
entering the quantity 100 F (100 micro Farads, a unit of electric capacitance).  Click in
your worksheet and type:  100 ' m Cntl-g F, then type the equal sign (=).  The result is
shown below:

Notice that when you type the single quote (apostrophe) symbol, SMath Studio shows the
following symbol to indicate an impending unit insertion (call this symbol the unit
placeholder):  
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Try the following example where we perform a calculation using units:

2.5 'mg * 10.5 'ft [space] / ( 1.25 'hr [][] ^ 2 =

The result is given, by default, in units of the International System (SI):

Converting units in a result
The result thus obtained can be expressed in other units by clicking to the right of the N,
which produces a small, black, rectangular placeholder as shown below:

Click on the placeholder so that the placeholder gets selected, as illustrated here:

Then, type the replacement unit(s).  For example, if we want to show the previous result
using micronewtons (N), type, in the placeholder, 'm Cntl-g N, i.e.,

By a similar procedure we can replace the units with millinewtons (mN) as follows: click
on the right-hand side of the N units, press the [ ← Backspace] key twice to remove the
units, so that the unit placeholder shows up, i.e., 

Now, type mN, to get1:

1When the unit place holder is active, there is no need to type the single-quote (apostrophe) symbol to enter
units.
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Defining your own units
Suppose that you wanted to see the result in nanonewtons (nN).  Attempting to replace
the micronewtons (mN) with nanonewtons (nN), we obtain the following result:

The unit substitution was not accomplished because the nanonewton unit (nN) is not
defined.  You can check this by using the option Insert > Unit …  and select the Force
category in the resulting menu:

The units are listed in alphabetical order and, obviously, there is no nanonewton (nN)
units listed.  (Press the [Cancel] button to remove the menu.)  Hence the impossibility of
replacing N with nN.  

You can, however, define your own units if they're missing.  For example, to define the
symbol for nanonewtons (nN) you can type: 

'nN : 10 ^ -9 'N 

This definition must be entered at a location in the worksheet above the point where the
calculation takes place.  In this case, the conversion to nanonewton (nN) is successfully
performed as shown below:

page 18               © Gilberto E. Urroz, May 2010



Physical constants available
The collection of units in SMath Studio include two physical constants referred to by their
typical symbol.  These are the speed of light in vacuum (referred to as c), and the
standard acceleration of gravity (referred to as g).  In SMath Studio you can show the
values of those constants using the notation for units.  For example, to see the value of c
type 'c = , or type 'g = to see the value of g.

Units of the English System
In the United States of America, and in a few other countries, the traditional system of
units, known as either the English system (ES) or imperial system, is still very much in
use.  Therefore, SMath Studio includes in their collection of units such ES units as
horsepower (see example above), lb (pounds), ft (foot, or feet), in (inches), etc.   For
example, the values of the speed of light in vacuum and the standard acceleration of
gravity in units of the English system are:

Are pounds units of mass or force?
Modern usage in the physical sciences requires that the pound, lb, be used as a unit of
force, with the corresponding unit of mass being the slug, defined as 1 slug = 14.5939 kg.
However, in buying produce (e.g., meat, grain, etc.), the pound can be used as a unit of
mass with the conversion 1 kg = 2.2 lb.  In SMath Studio the pound, lb, as well as the
ounce, oz, are used as a units of mass (Note: 1 lb = 16  oz).  The corresponding unit of
force is the pound-force, lbf, defined as 1 lbf = 4.4482 N.   Thus, in physical science
applications use the pound-force, lbf, when you are required to use pounds as a unit of
force.  Another commonly used unit of force is the kip (kilopound) equal to 1000 lbf.  

What about the kilogram?
The kilogram is the basic unit of mass in the International System (SI).  Nevertheless,
there is a unit of force called the kilogram-force, kgf, corresponding to the weight of 1 kg.
The definition of kgf is, therefore, 9.8066 N.  

The   cgs   system  
Before the adoption of the Systeme International (SI, or International System), back in
1960, metric units used in the physical sciences were grouped into two systems, called
the MKS (meter-kilogram-second) and the cgs (centimeter-gram-second).   The MKS
system became the basis of the SI.  The cgs system is used for applications requiring
small masses and/or distances.  The units of force and work (or energy) in the MKS (now
the SI) system are the newton (N) and the joule (J), respectively.  The units of force and
work/energy in the cgs system are the dyne and the erg.   The units in the SI and the cgs
systems are related by: 1 N = 10 5 dyne, 1 J = 10 7 erg.   SMath Studio includes the dyne,
but not the erg, in its collection of units.  
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Working with variables and units
Units can be attached to numerical values assigned to variables.  The results of operations
with these variables will be given in the basic SI units.  Here are some examples:

Example 1:  Universal gravitation law.  Calculating the force between masses m1 and m2,
separated by a distance d.  The formula, shown below, requires us to use the universal
gravitational constant G, found elsewhere:

Example 2: Relativistic mass – The equation below, belonging to Einstein's Special
Theory of Relativity, is used to calculate the mass of a body moving at a velocity v if the
rest mass is m0.  

Notice that in the equation above we used the symbol for c from the collection of Units in
SMath Studio.  

Documenting the worksheet
In order to document your worksheet, you can add text to it by clicking on any place in
the worksheet and typing the double-quote symbol ” followed by the text.  (Alternatively,
you can use the option Insert>Text Region in the worksheet menu).  For example, the
following figure shows assignment statements interposed with text regions to produce a
readable document.
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By dragging the cursor over the region where these fields were entered you can see all the
fields involved, both text regions and mathematical fields:

Selecting worksheet fields for editing and repositioning
If you click on any of the text lines or the operations shown above, the corresponding
field will be shown enclosed in a rectangle.  This indicates that the field can be edited for
text or math calculations.  An example is shown below:

A text or calculation field can also be selected by clicking in a region near the field and
dragging the mouse towards the field.   In this case, the field is enclosed by a frame with
blue boundaries and a blue background, e.g.,  

When selected in this way, a field can be dragged and positioned somewhere else in the
worksheet.  For example, the result shown above could be re-organized as follows:

A field selected by dragging can be erased from the worksheet by pressing the [delete] or
the [backspace] key.   The selected field can also be copied and pasted by using Ctrl-C
and Ctrl-V, respectively.  By dragging on top of two or more fields, multiple fields can be
selected simultaneously for editing.
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Horizontal and vertical alignment of cells
Items (13) and (14) in the SMath Studio toolbar (see figure below) provide for horizontal
and vertical alignment of cells in the worksheet.

Consider the following text and calculation cells that are misaligned horizontally:

The four cells were selected by dragging the mouse, while holding the left button, over
the cells.  Next, press button (14) in the toolbar to get the following result:

Now, for an exercise on vertical alignment, consider the following vertically misaligned
cells:

After pressing button (15) in the toolbar we get the following result:
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Adding images to the worksheet
Images scanned into the computer or produced by other graphic software can be
incorporated into your worksheet in different ways.  

1 – Copying a figure from other software, clicking and using Paste (or Ctrl-v).

2 – Using Insert > Picture > From file …, to insert a picture contained in a file.

3 – Using Insert > Picture > Create …, to insert a picture frame where you can draw
your own picture.  Use the mouse as a pencil.  SMath Studio  does not provide for other
drawing tools

Examples of the three cases are illustrated below.  The only images allowed to insert
from a file are bitmap images.  Through the cut-and-paste procedure, you can paste
images from any format.

By selecting the field containing a figure, the figure can be repositioned in the worksheet.
Be careful, however, when dragging your mouse across a figure whose field has not been
highlighted.  In such case, the mouse dragged across the figure will add lines to the figure
that you may not intended to add.  In such case use the Undo button in the menu.  

With text and calculation cells, plus image cells imported into or created within SMath
Studio, you can produce technical reports as would be required for class assignments or
for an engineering project.  

page 23               © Gilberto E. Urroz, May 2010



Application – Writing an assignment in SMath Studio
The figure below shows a class assignment in fluid mechanics/hydraulics prepared in
SMath Studio.

If you prefer, you can click off the grid using the View menu to produce the following:

Note: To enter multiple lines in a text box, use Shift-Enter at the end of each line.
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Predefined functions for real and complex numbers in SMath Studio
This section shows examples of predefined, or intrinsic, functions for both real and
complex numbers available in SMath Studio.

Functions for real numbers 
The following functions are available for application to real numbers:

• abs absolute value
• exp exponential function 
• Gamma Gamma () function
• ln natural logarithm, i.e., logarithm of base e 
• log logarithm of any base 
• log10 logarithm of base 10
• mod modulus 
• nthroot the n-th root of a number
• numden decompose a fraction into numerator and denominator
• perc percentage
• round rounds to an integer
• sign extracts the sign
• sqrt square root
• random generates a random number

These functions are available, unclassified, by using the Insert > Function menu and then
selecting the All category of functions:
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Some of these functions are also available in the Functions
palette: The Function palette includes also trigonometric
functions (sin, cos, tan,cot), calculus expressions (summation,
product, derivative, integral), functions that apply to matrices (el),
and functions that apply to graphs (the last three symbols in the
last line).

Some of these functions are also available in the Arithmetic
palette.  These include the absolute value (abs), the square root
(sqrt), and the n-th root (nthroot) functions.  Also shown in the
Arithmetic palette are the following items:

• Mathematical Constants:  Positive infinity (), Pi (),
Imaginary unit (i)

• Numerical Digits: 0-9
• Arithmetic operators: , +, -, , /, power
• Evaluation operators: Definition (:=), Numerical Evaluation (=), Symbolic

Evaluation (→)
• Postfix Operators: Factorial (!)
• Editing Characters: Decimal point (.), Comma (,), Backspace (←)

Since trigonometric and hyperbolic functions apply also to real numbers, we provide a
list of those functions available under the Function – Insert form (see above) under the
headings Trigonometric and   Hyperbolic  :  

Trigonometric:
• sin sine
• cos cosine
• tan tangent
• cot cotangent
• sec secant
• csc cosecant

• asin inverse sine
• acos inverse cosine
• atan inverse tangent
• acot inverse cotanget
• arcsec inverse secant
• arccosec inverse cosecant

Hyperbolic:
• sinh hyperbolic sine
• cosh hyperbolic cosine
• tanh hyperbolic tangent
• coth hyperbolic cotangent
• sech hyperbolic secant

• csch hyperbolic cosecant
• asinh inverse hyperbolic sine
• acosh inverse hyperbolic cosine
• atanh inverse hyperbolic tangent
• acoth inverse hyperbolic cotanget

Examples of functions applied to real numbers
These functions can be inserted from the Functions – Insert form (Insert > Function
menu), the Functions palette, or simply by typing the name of the function into a region
of the SMath Studio worksheet.   The following are examples of real-number functions in
SMath Studio:
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The mod function applies to integers only, and it's described in the following example:

Function numdem, shown below, separates a fraction into a numerator and a
denominator:

Notice that, in its numerical evaluation, the last example shows both numerator and
denominator multiplied by 1015.  These two factors obviously cancel when the fraction is
put together again, but it serves to emphasize that SMath Studio calculates values with 15
decimals.
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More functions for real numbers are shown next:

Function rand is used to produce random numbers, as indicated below:

page 28               © Gilberto E. Urroz, May 2010



Functions exclusive for complex numbers
The Function – Insert  form provides the following functions that apply exclusively to
complex numbers (let z = x+iy  represent a complex number):

• arg angle in complex plane, arg(z) = atan(y/x)
• Im imaginary part, Im(z) = y
• pol2xy convert polar coordinates to rectangular coordinates
• Re real part, Re(z) = x
• xy2pol convert rectangular coordinates to polar coordinates

The following examples show applications of these functions to complex numbers:

The function abs, when applied to a complex number, produces the modulo (length) of
the complex number.  Function abs is not included in the listing of Complex Numbers
functions in the Insert – Function form.  However, abs, and many other functions that we
applied to real numbers above, can be applied to complex numbers as illustrated next:
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Rectangular and polar representation of complex numbers
A complex number written in the form z = x + iy is
in its rectangular (or Cartesian) representation.
Thus, it can be written also as the ordered pair (x,y),
and be represented in an Argand diagram in which
the abscissa is x and the ordinate is iy.  An alternative
way to represent point (x,y) is through its polar
representation whose coordinates are (r,).  The
proper way to write the polar representation of a

complex number is through the use of Euler's formula: ei=cosisin  .  With
this result,   

 z=xiy=r cos i r sin =r cos i sin=r ei .

SMath Studio provides functions xy2pol to convert from rectangular (x,y) into polar (r,)
coordinates, and pol2xy to convert from polar (r,) to rectangular (x,y) coordinates.
Thus, with these functions one can go easily go from rectangular to polar representations
of a complex number, and vice versa.  

In the following example we convert from rectangular to polar representations of a
complex number:

The following example shows a conversion from polar to rectangular representations of a
complex number:
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Operations with complex numbers
The following examples show operations with complex numbers in SMath Studio:

The complex conjugate of a complex number is the
reflection of the number z = x + iy about the x axis,
i.e., z = x – iy.  This is illustrated in the figure to
the right:

All other operations follow the rules of algebra with the caveat
that i2 = -1, etc.  Other powers of the unit imaginary number
are shown in the vector to the left.

Using the conjugate we can write: z⋅z=r 2 .
This calculation is illustrated below:
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The Gamma function
Most readers with courses in Algebra and Calculus I will be already familiar with most of
the functions for real and complex numbers presented in this document.  The Gamma
function may be an exception, since it is an advanced mathematical function and
probably would not have been introduced in those courses.  The Gamma function is
defined by an integral, namely, 

x =∫
0

∞

t z−1e−t dt .

The Gamma function is related to the factorial operator as follows:  x1= x ! , if x
is an integer.

The following examples use the Gamma function in some calculations:

Note: the Gamma function currently defined in SMath Studio 0.85 cannot handle negative
arguments, or complex arguments whose real part is negative.  For many applications this
definition will be fine, but the full definition of the Gamma function should be able to
handle negative arguments.  Based on the paper “A note on the computation of the
convergent Lanczos complex Gamma approximation” by Paul Godfrey (2001), found in
http://home.att.net/~numericana/answer/info/godfrey.htm#lanczoscoeffs , I redefined the
Gamma function to include negative arguments, as follows:

The figure to the right also shows some
calculations of the modified Gamma function,
and a graph of the function.

Compare the graph with that shown in the one
shown in the wikipedia entry:

http://en.wikipedia.org/wiki/Gamma_function
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User-defined functions
You can define your own functions by using the expression 

function_name(argument(s)): function_expression

Examples of definitions and evaluations of functions are shown below:

Plots of functions in 2D – a brief introduction
SMath Studio allows the user to insert two-dimensional (2D) plots by using the 2D option
in the Plot palette, or the menu option Insert > Plot > 2D.  This action will open a 2-D
graph window, as illustrated below:

In the place holder on the lower left corner of the graph window you can enter the name
of a function to plot, e.g., 
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If you click on the graph window, you can drag one of the window handles shown below
(right-hand side, bottom, or lower right corner) to modify the size of the window. 

Some resizing examples are illustrated below:

page 34               © Gilberto E. Urroz, May 2010



Plotting more than one function
To plot one than one function, use the Equation systems option in the Functions palette,
namely,

,

to insert more than one function in the function placeholder for the graph window.  Here
is an example:

Plots of functions in 3D – a brief introduction
Use the 3D option in the Plots palette, or the
menu option Insert > Plots > 3D.   Type the
equation f(x,y) in the place holder located in
the lower left corner of the graph window.
You can drag the mouse pointer in the graph
window to rotate the graph for a better view
of the mesh surface, as illustrated here:

Resizing of the graph is also possible as done
for 2D graphs.

As we did with 2D plots, you can plot
more than one 3D plot as illustrated in
the graph to the left.
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Additional manipulation of graphs
Additional manipulation of graphs is possible using the Plot
palette.  The Plot palette includes the following buttons:

(1) Rotate – for 3D graphs, default setting 
(2) Scale – With  Ctrl or Shift, while dragging mouse over the graph, for proportional

scaling – play around with this command to understand its operation
(3) Move – move the graph around in existing graph window
(4) Graph by points – show graph made of discrete points
(5) Graph by lines – show graphs made of continuous lines
(6) Refresh – refresh graph window to its default settings

Try these options on your own to learn more about the different Plot palette actions.  The
example below shows a proportional scaling using item (3) above, while holding down
the Shift key.

NOTES:  (1) For additional examples of 2D and 3D graphics see Appendix 1.                  
                (2) For examples of 2D geometric figures see Appendix 2.                                 

Plotting your own functions
Define a function as indicated earlier, and replace the function name in the graph window
place holder.  Here is an example:
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Defining functions with the if function
Some functions require more than one expression for their definition.  For example,









2,

2,1
)( 2 xx

xx
xF .

This function can be defined using the if function in the
Programming palette.  When selecting this option, the
following programming structure, with placeholders, is
produced:

  
              To program the function 
              shown above, we can use:  

If the definition of the function requires more than two expressions, it will be necessary
to use nested if programming structures. Consider the following example:

Function defined as:                                                     Function programmed as:

    














4,)1(

42,)1(

2,1

)(
3

2

xx

xx

xx

xF

A plot of this function is shown below:

More details on programming in SMath Suite will be provided in a later section.
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Functions defined by calculus operations
The Functions palette include four operations that are proper from calculus: summation,
product, derivative, and integrals.  These functions can be incorporated in the definition
of functions as illustrated in the following examples:

Notice that the functions f(x) and g(x), whose argument defines the upper limit of the
summation and product, are only defined for integer values.  

Solving single equations with solve
Function solve can be used to solve single equations.  The function can be called using
either of the following calls:

solve(equation, variable)
or

solve(equation, variable, lower limit, upper limit)

Examples using both symbolic and numeric results are shown below:

Function solve provides only real roots.  Polynomial equations can be solved using
polyroots, as described below. 

Note: to enter the Boolean equal sign (bold =) use
Ctrl+=, or the symbol in the Boolean palette.
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Application:  Solving for the flow depth in an open channel flow 
The following example shows how to use function solve to calculate the normal depth of
flow in an open channel flow of circular cross-section.  The problem statement and
solution commentaries were all entered using SMath Studio.  Also, a figure was created
using Window's Paint and pasted into the SMath Studio worksheet.  To facilitate the
solution, units were not used.  The solution shown is y = 1.7077 ft.
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Changing the number of decimals in the output
Most of the numeric calculations and equation solutions shown so far in this document
use four decimals (default value).  Using the Tools > Options menu item you can change
the number of decimals in the output.  For example, changing to 15 decimals for output,
we solve the equation presented above to obtain the following results:

For the rest of the examples in this document we
will use the default number of decimal figures,
i.e., 4 decimals.

Solving polynomial equations with polyroots
Function polyroots returns the roots of a polynomial using as argument a column vector
with the polynomial coefficients.  The coefficients must be entered in the vector in
increasing order of the power of the independent variable.  For example, the vector
corresponding to the polynomial 1 + 2x - 5x2   is:




















5

2

1

v .

Using SMath Studio, the roots of this polynomial are calculated as follows:

To enter a column vector, a row vector, or a matrix, use the first
icon in the Matrices palette.  This icon opens a dialogue box
where the user can select the number of rows and columns for
defining a vector or matrix.  By default, the dialogue box uses a 3×3 matrix.  For the
column vector v, shown above, we used, of course, 3 rows and 1 column:
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Unlike function solve, which provides only real functions, function polyroots provides
either real or complex roots, or both.  For example:

Application: Solving homogeneous, linear, constant-coefficients ODEs 
A n-th order, homogeneous, linear ordinary differential equation (ODE) with constant
coefficients is represented by the expression:

Introducing the notation Dn = dn( )/dtn, the general n-th order equation can be written as:

.
This expression can be “factored” in terms of the D operators to read:

If we take the expression between parentheses and replace the D operators with the
variable  and make it equal to zero, we would have produced the so-called
characteristic equation of the ODE, i.e., 

There are, in principle, n solutions of this polynomial equation, namely, 1, 2, ..., n.

Some of these solutions could be complex (or imaginary), or even repeated. In the case
that all solutions are real and non-repeating, the general solution to the original
homogeneous ODE is given by:

.

If a root m, repeats k times, it will result in k terms in the solution given by 

)( 12
321

 k
k

t tAtAtAAe m 
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If there are complex roots, they will be an even number of them, i.e., pairs of complex
conjugates.   Thus, if one of those pairs of complex conjugate roots is 1 =  +  i and 2

=  -  i, then the following terms will appear in the solution:

)sin()cos( 21 teAteA tt   

Function polyroots can be used to solve the characteristic equation, or characteristic
polynomial, for an n-th order, homogeneous, linear ODE.  The roots of the characteristic
polynomial can then be used to build the solution.  One example is shown below.

The calculation of derivatives is all performed using symbolic calculations, and the
results are very long.  Also, the current version of SMath Studio (version 0.85, 09/2009)
doesn't simplify results and keeps the value exp(0) instead of 1.  Helping SMath Studio
with these shortcomings, and with a lot of patience, you can get to put together the
system of linear equations needed to solve for the coefficients A1, A2, and A3, in the
solution to this ODE. (The figure below shows only parts of some calculations).

page 42               © Gilberto E. Urroz, May 2010



The resulting equations can be summarized as follows:
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And, since we are dealing with matrices already, we introduce their use in SMath Studio
next.

Operations with matrices
The functions available under the Insert > Function menu under the heading Matrix and
vector can be roughly classified into the following categories:

 Creating matrices: augment, diag, identity, mat, matrix, stack
 Extracting rows, columns, elements: col, el, row, submatrix, vminor, minor
 Characterizing matrices: cols, det, length, max, min, norm1, norme, normi, rank, rows, tr

 Sorting functions: csort, reverse, rsort, sort
 Matrix operations: alg, invert, transpose

Some of these functions are also available in the Matrices
palette:

  (1) Matrix 3x3 (Ctrl+M) (mat)
  (2) Determinant (det) 
  (3) Matrix transpose (Ctrl+1) (transpose)
  (4) Algebraic addition to matrix (alg)
  (5) Minor (minor)
  (6) Cross product

The only function from the Matrices palette not available from the Insert > Function >
Matrix and vector functions is (6) Cross product, which applies to two vectors of three
elements.    

It is important to indicate that even though you can form row vectors, many of the matrix
and vector functions defined in SMath Studio apply only to column vectors.  Thus,
column vectors are considered true vectors for the purpose of matrix operations in SMath
Studio.   For example, to calculate a cross-product you will need two column vectors of
three elements.  Dot products, on the other hand, can be performed on column vectors of
any length.  The dot product of two column vectors is calculated as the matrix product of
the transpose of one of the vectors times the second vector.  Examples of matrix and
vector operations follow.  The vector and matrix names used in the examples suggest the
dimensions of the vector or matrix.  For example, u2x1 suggest the vector u2×1, and A3x3
suggests the matrix A3×3.
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Examples of matrix creation:

Examples of extracting rows, columns, or elements from matrices:
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Examples of matrix characterization:

Examples of matrix/vector sorting functions:  

'
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Examples of matrix operations:

Examples of vector products:

Ranges and vectors
Function  range is  used  to  generate  a  vector  (column  vector)  with  elements  equally
spaced.  The general form of the range function is as follows:

 range(start, end): shows up in the worksheet as start..end, and produces a vector
whose elements are start, start + 1, start + 2, etc.  The last element is the lowest
value smaller than last by less than one. 

 range(start,  end,  start+increment):  shows  up  in  the  worksheet  as  start,
start+increment .. end, and produces a vectors whose elements are start, start +
increment, start + 2 increment, etc.  The last element is the lowest value smaller
than end by less than increment.  
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The following examples illustrate the use of function range.  The examples are numbered
1  through  7.   Immediately  below the  Example  number  the  range function  call  that
produces  the  range  is  shown.   For  instance,  in  Example  1,  typing  the  expression
range(0,10) produces the range 0..10, assigned to k.  

 Example 1 shows a vector from 0  to 10 with default increment of 1.
 Example 2 shows a vector from 0 to 20  with increment of 2.
 Example 3 shows a vector from 1.2 to 4.4 with default increment of 1.

 Example 4 shows an impossibility since the value of start + increment < start, but
end > start

 Example 5 shows a vector from 1.2 to 4.4 in increments of 2
 Example 6 shows a vector from 0.5 to 5 in increments of 0.5
 Example 7 shows a vector from 10 down to 1 in negative increments of -1

page 48               © Gilberto E. Urroz, May 2010



Vectors can be combined linearly to produce other vectors, as illustrated here:

The following examples illustrate three different ways to calculate products of vectors of
the same lengths: 

1. Product of the vectors produces the scalar (dot) product
2. Product of a vector transpose with another vector produces the same scalar (dot)

product as the only element of a 1×1 matrix
3. Product of a vector with the transpose of another vector produces a matrix

Individual elements of a vector can be extracted by using the name of the
vector with a sub-index.  To enter a sub-index, type the name of the vector
and press the left square bracket key ([).  Press the right arrow key [] a
couple of times to select the indexed variable.  Examples:

Vectors of the same length can be put together in a matrix through function augment:

This can be used to build tables of data.
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for loops and parametric plots
A parametric plot is defined by points (x(t), y(t)), where t  is referred to as the parameter.
In this example we generate data (x,y) and (y,x) using for loops, and plotting the resulting
matrices.

Commands in the Programming palette
The Programming palette includes four commands, namely, if,
while,  for,  and  line.   We  have  presented  examples  of  the
commands  if,  for,  and  line,  in  this  document.   Here  is  an
example of the while command:
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Introduction to Programming with SMath Studio
In this section we introduce basic concepts of programming for numerical solutions in
SMath Studio.

Programming structures and flowcharts
Programming, in the context of numerical applications, simply means controlling a
computer, o other calculating device, to produce a certain numerical output.  In this
context, we recognize three main programming structures, namely, (a) sequential
structures; (b) decision structures; and (c) loop structures.  Most numerical calculations
with the aid of computers or other programmable calculating devices (e.g., calculators)
can be accomplished by using one of more of these structures.

The operation of these programming structures will be illustrated by the use of flow
charts.  A flow chart is just a graphical representation of the process being programmed.
It charts the flow of the programming process, thus its name.  The figure below shows
some of the most commonly used symbols in flowcharts:

In a flowcharts, these symbols would be connected by arrows pointing in the direction of
the process flow.  

Sequential structures
A complete programming flowchart would have start and end points, and at least one
process block in between.  That would constitute the simplest case of a sequential
structure.  The following figure shows a sequential structure for the calculation of a sum:

This flowchart can be simplified slightly by using a single input block to enter both a and
b:

Typically, a sequential structure is shown following a vertical direction:
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The sequential structure shown in this flowchart can also be
represented using pseudo-code.  Pseudo-code is simply writing the
program process in a manner resembling common language, e.g., 

Start
Input a, b
c  a + b2

Display c
End

A flowchart or pseudo-code can be translated into code in different
ways, depending on the programming language used.  In SMath
Studio, this sequential structure could be translated into the
following commands:

Here is another example of a sequential structure in SMath Studio showing more than one
calculation step.  The sequential structure in SMath Studio doesn't have to follow a strict
vertical direction, as illustrated below. 

The   line   command and the   Programming   palette  
The sequential structure is shown in the right-hand side of the figure above collecting the
calculation steps under a programming line.   The figure below illustrate the instructions
to insert a programming line in a SMath Studio worksheet.  The line command, together
with other programming commands, is listed in the
Programming palette shown here:

2The algorithmic statement c ← a+b represents the assignment c := a + b in SMath Studio
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The line command can be used to add sequential structures to entry points in other
programming instructions as will be illustrated below.

Decision structure 
A decision structure provides for an alternative path to the program process flow based
on whether a logical statement is true or false.  As an example of a decision structure,
consider the flowchart for the function  listed below:

The flowchart is shown on the right.   The
corresponding pseudo-code is shown below:

start
input x
if  x < -1  then
   y  |x+1|
else
   y  |x-1|
display x,y
end

In SMath Studio a decision structure is entered
using the if command.  Instructions on entering the
if command are shown below:
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To illustrate the use of the if command within SMath Studio, we enter
the function f(x), defined above, as shown here: →  →  →  →  →  →  

Logical statements and logical operations
Decision structures require a condition to trigger a decision on the program flow.  Such
condition is represented by a logical statement.  Within the context of programming
numerical calculations, a logical statement is a mathematical statement that can be either
true or false, e.g., 3>2, 5<2, etc.  In SMath Studio the logical outcomes true and false are
represented by the integer values 1 and 0, respectively.  

The following figure illustrates examples of logical statements.  It also includes examples
of the four logical operations: (1) negation (not  ); (2) conjunction (and  ); (3)
disjunction (or ); and, (4) exclusive or (xor ).  The figure also includes the truth tables
for these four operations.  A truth table is a table showing the outcome of all possible
combinations of true and false statements.

The symbols for the comparison operators (=, <, >, ,  , ) and
logical operations ( ,  , ,   ) are available in the Boolean
palette shown here:

Notice the presence of the Boolean equal (bold =) which represents a comparison, rather
than an evaluation.  The Boolean equal sign can be used to define equations in SMath
Studio, e.g., in this solve command:
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Examples of   if   statements used to define functions  
The following figure illustrates other examples of if statements used in the definitions of
functions:

Nested   if   statements  
Decision structures, i.e., if statements, can be nested  as illustrated below:

Combination of   if   statements with   line   statements  
The following two examples illustrate an if statement that exchanges the values of two
variables x and y if x<y, or changes the signs of both variables otherwise.  In the first
case, x<y, thus, the values get exchanged:
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In the second case, x<y, thus the else clause is activated and both x and y have their signs
changed:

Loop structures
In a loop structure the process flow is repeated a finite number of times before being send
out of the loop.  The middle part of the flowchart to the right illustrates a loop structure.
The flowchart shown represents the calculation of a sum, namely, 

Sn=∑
k=1

n
1
k

.  

The sum Sn is initialized as Sn ← 0, and  an index, k, is
initialized as k ← 0  before the control is passed on to the
loop.  The loop starts incrementing k and then it checks if the
index k  is larger than its maximum value n.  The sum is
incremented within the loop, Sn ← Sn + 1/k, and the process is
repeated until the condition k>n is satisfied.  After the
condition in the decision block is satisfied (T = true), the
control is sent out of the loop to the display block.

In terms of programming statements, there are two possible
commands in SMath Studio to produce a loop: while and for.
The pseudo-code for a while loop interpreting the flowchart to
the right is shown below:

start
input n
Sn  0
k  0
do while ~(k>n)
   k  k + 1
   Sn Sn + 1/k
end loop
display n, Sn
end

Since a while loop checks the condition at the top of the loop,
the condition was converted to ~ (k > n), i.e., 
not(k>n) = k   n.  
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The   while   command in   SMath Studio  

The pseudo-code listed above is translated as follows in SMath Studio: 

 

This summation can also be calculated using SMath Studio's summation command:

Here is another example of a while loop in SMath Studio:

While loops can be nested as illustrated in the left-hand side of the figure shown below.
The corresponding double summation is shown on the right-hand side of the figure
below.  
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The figure to the right shows an alternative flowchart for calculating the summation:

Sn=∑
k=1

n
1
k

The hexagonal symbol in the flowchart shows three
elements: (1) the initialization of the index, k ← 1; (2) the
index being incremented, 
k ← k + 1; and, (3) the condition checked to exit the loop, k
> n.  This hexagonal symbol represents the   for   command  for
this summation.  

A more general symbol for a for command is shown
below.  This symbol shows a for loop with index k,
starting at value k0, and ending at  value kf, with
increment k:

The index, therefore, takes values k = k0, k0+k, k0+2k,…, kend, such that kend  kf, within
one k. 
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The   for   and   range   commands in   SMath Studio  

The for command in SMath Studio uses a range of values to indicate the values that the
index k takes to complete the loop.  
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Here is an example of the for command in SMath Studio using the range 1..10:

The double summation programmed earlier using while loops, can be programmed also
using for loops:

A programming example using sequential, decision, and loop structures
This example illustrates a program in SMath Studio that uses all three programming
structures.  This is the classic “bubble” sort algorithm in which, given a vector of values,
the smallest (“lighter”) value bubbles up to the top.  The program shown uses a row
vector rS, and refers to its elements using sub-indices, e.g., S1k, etc.  The example shows
how to enter sub-indices.  The output from the program is the sorted vector rS. 

page 60               © Gilberto E. Urroz, May 2010



Many programming applications, such as the one shown above, use vectors and matrices.
Luckily, SMath Studio already includes a good number of functions that apply to
matrices, e.g,:

 Creating matrices: augment, diag, identity, mat, matrix, stack
 Extracting rows, columns, elements: col, el, row, submatrix, vminor, minor
 Characterizing matrices: cols, det, length, max, min, norm1, norme, normi, rank,

rows, tr
 Sorting functions: csort, reverse, rsort, sort
 Matrix operations: alg, invert, transpose

Some of these functions are also available in the Matrices
palette:
  (1) Matrix 3x3 (Ctrl+M) (mat)
  (2) Determinant (det) 
  (3) Matrix transpose (Ctrl+1) (transpose)
  (4) Algebraic addition to matrix (alg)
  (5) Minor (minor)
  (6) Cross product

Examples of matrix operations were presented earlier.
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Steps in programming
The following are recommended steps to produce efficient programs:

(1) Clearly define problem being solved
(2) Define inputs and outputs of the program 
(3) Design the algorithm using flowcharts or pseudo-code
(4) Program algorithm in a programming language 
             (e.g., SMath Studio programming commands)
(5) Test code with a set of known values

Errors in programming
Typically there are three main types of errors in developing a program:

(1) Syntax errors: when the command doesn't follow the programming language
syntax.  These are easy to detect as the program itself will let you know of the syntax
violations.

(2) Run-time errors: errors due to mathematical inconsistencies, e.g., division by
zero.  These may be detected by the program also.

(3) Logical errors: these are errors in the algorithm itself.  These are more difficult to
detect, thus the need to test your programs with known values.  Check every step of your
algorithm to make sure that it is doing what you intend to do.

Notes: Appendices 3 through 6 show examples of programs used to solve selected         .
problems in numerical methods, namely:                                                                            
                                                                                                                                             
          Appendix 3 - The Newton-Raphson for solving equations                                        
          Appendix 4 - The 4th-order Runge-Kutta method for a single ODE                         
          Appendix 5 - The 4th-order Runge-Kutta method for a system of ODEs                  
          Appendix 6 - The 4th-order Runge-Kutta method for a 2nd order ODE                  .
          Appendix 7 – Finding eigenvalues and eigenvectors of a matrix                             .
                                                                                                                                              

Input/Output of data and file manipulation in SMath Studio
SMath Studio provides functions wfile, rfile, and dfile for output into a file, input from a
file, and deleting an existing file.  To illustrate the use of these functions we could start
by writing some data to a file and exploring the contents of the file.  Before we do that,
however, I want to address an issue related to the location of the SMath Studio
installation folder.

The location of the  SMath Studio installation folder
When I first attempted to use I/O functions` after installing SMath Studio in my Windows
Vista Ultimate 64-bit machine I kept getting a message indicating that access to the file
location was not permitted.  This was so because SMath Studio, by default, sends output

page 62               © Gilberto E. Urroz, May 2010



to and reads input from the folder /*SMath Studio Installation Folder*/user/.   In my
computer, the *SMath Studio Installation Folder* corresponds to the directory
C:\Program Files(x86)\SMath\SMath Studio\ and it requires Administrator access to
modify its contents.  To be able to write data from and read data into SMath Studio,
therefore, I copied the folder C:\Program Files(x86)\SMath\ to a different location.  In
my case the location chosen was:

C:\Users\Gilberto E. Urroz\Documents\NUMERICAL_APPLICATIONS\SMath

In your computer it could be any location where you don't need Administrator rights to
modify content.  I then proceeded to create the folder user, where the data files would
reside.  Thus, the full address of this new folder, in my case, is:

C:\Users\Gilberto E. Urroz\Documents\NUMERICAL_APPLICATIONS\SMath\SMath
Studio\user

To facilitate access to the program, at this point, I created a new shortcut to SMath Studio
in my desktop.  Now we proceed to illustrate the use of the wfile command.

Writing data to a file
You can use function wfile to write a single item of data into a file.  Consider the
following examples3:

You can open the files using, for example, Notepad  in a Windows system to check the
contents of the file:

3I recommend you use only lowercase letters in the filenames used to store data.  I had difficulties getting
SMath Studio to read data out of files with uppercase letters in their names.

page 63               © Gilberto E. Urroz, May 2010



Thus, you'll need to use the numerical result that you want to write out to a file as the first
argument of wfile.  Using the reference to a variable will only write the variable name.
The second argument to wfile is the name of the file, entered without quotes.  The file
name can only use letters and numbers.  No other characters are allowed in the name of a
file.

You can store a range or the resulting vector to a file, e.g.,

The contents of the corresponding files are shown below:

Regarding the notation mat(2,4,6,10,12,14,16,18,9,1) written in file file04: this
specification contains the 9 elements of the vector shown as s, above, plus the number of
rows (9) and columns (1) defining the vector.  Consider, for example, the writing of
matrices to files.  In the following two examples, the two matrices have 12 elements,
each, but arranged differently.  Matrix A has 3 rows and 4 columns, while matrix B has 3
rows and four columns.  They get stored into files file05 and file06, respectively, as
shown below:
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Next, we show the contents of the two files.  Notice the specification of rows and
columns as the last two values in the list of data:

 
Here is another example of using function wfile:

The contents of the file are:

Reading data from a file
To read data from a file use function rfile.  The following examples use the files we
created above (i.e., file01, file02, …, file07) to illustrate the use of function rfile.  The
result from reading data can be simply shown by using an equal sign(=), or assigned to a
variable by using the assignment operator (:=).  Try the following examples:
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Additional examples of reading from a file are shown below:

If you attempt to read from a non-existing file you'll get an error message:

Copying a matrix from a spreadsheet
Suppose you have the following 3x3 matrix (only the numbers, no labels, etc.) in an
OpenOffice.org Calc spreadsheet named myMatrix.ods:
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Save the file in csv (comma-separated values) format into your user folder in your SMath
Studio installation:

Then, close the newly saved file myMatrix.csv, and open it using Notepad (right-click on
the icon, and select Open with …):

 to see the contents of the file:

Copy the file contents into another text file, let's call it mymatrixfile4, and edit it to read:

4A few notes: (1) Use only lowercase letters in the name of the file.  I couldn't get SMath Studio to
recognize filenames that include uppercase letters.  (2) Make sure the filename to be read has no extension,
therefore, the file should be named, in this case, mymatrixfile, and not mymatrixfile.txt or mymatrixfile.dat,
etc.  (3) Do not try to simply use the same .csv file without an extension as your input file to SMath Studio.
It won't work.  You need to create a new file.
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Thus, the editing consisted in:

1. adding “mat(“ at the beginning of the line
2. placing all the data into a single line
3. replacing the missing commas (between 5.1 and 7.8, and between 2.5 and 6.4)
4. adding “3,3)” at the end of the line.

Save this file and then try the command:

Of course, to get this simple 3x3 matrix into SMath Studio it will be easier to type it in
into the worksheet.  The procedure illustrated above would be more practical for very
large spreadsheet data sets. 

Writing and reading symbolic expressions
The following examples illustrate the writing of expressions to a file, and the reading of
the same expressions from files.  

The contents of the files are shown below:
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The following example shows writing and reading of a matrix of symbolic expressions:

The content of the file is shown below:

Deleting files
Use function dfile(filename) to delete files in the folder /*SMath Studio Installation
Folder*/user.  Examples:

The directory /*SMath Studio Installation Folder*/user is shown below before and after
the execution of the dfile commands shown above:
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Application of functions wfile, rfile, and dfile could be useful in programming if there is a
need to store data temporarily in a file.  
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APPENDIX 1 - Examples of two- and three-dimensionalgraphics in Smath Studio
--------------------------------------------------------------------------

Plotting a single function of x:

sin x
-16 -8 0 8 16

12

8

4

0

-4

-8

12

x

y 1 - Click on point in your worksheet
where upper left corner of graph
will go

2 - Click on the "2D" option in the
"Functions" palette or use the
"Insert > Graph > 2D" menu option

3 - Type the function name in the
placeholder below the graph

In this example we plot the
function: f(x) = sin(x)

Changing the size of the graph window:

Click on the graph window, then drag one of the three
black handlers in the graph window to adjust its size

sin x
0

64

48

32

16

0 x

y

sin x
-8 -4 0 4 8

2

0

-2

x

y

sin x
-16 -8 0 8 1

8

4

0

-4

-8

x

y
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Moving the axes about the graph window:

sin x
-24 -16 -8 0 8

16

12

8

4

0

-4

x

y

sin x
-8 0 8 16 24

4

0

-4

-8

-12

-16

x

y

1 - Click on the "Move" option in the "Plot" palette
2 - Click on the graph window and drag the mouse in the direction where you want
to move the axes.

Scaling (zooming) the graph:

sin x
-2 -1 0 1 2

12

8

4

0

-4

-8

12

x

y <--- To zoom the x-axis only:
1 - Click on "Scale" in the "Plot" palette
2 - Click on the graph window
3 - Hold down the "Shift" key
4 - Roll the mouse wheel up or down

sin x
-16 -8 0 8 16

1

0.5

0

-0.5

-1

x

y

To zoom the x-axis only: ---->
1 - Click on "Scale" in the "Plot" palette
2 - Click on the graph window
3 - Hold down the "Control" key
4 - Roll the mouse wheel up or down

sin x
-6 -4 -2 0 2 4 6

0.75

0.5

0.25

0

-0.25

-0.5

-0.75

x

y

<--- You can zoom both axes by zooming one
axis at a time. In this case, I zoomed
the x axis first, and then the y axis.
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Note: Use the "Refresh" option in the "Plot" menu
to recover the original version of any plot.

Plotting various functions simultaneously:

cos x

sin x
-16 -8 0 8 16

12

8

4

0

-4

-8

12

x

y
1 - create a 2D graph
2 - click on the function placeholder
(lower left corner) to select it
3 - click on the "Equation System"

option in the "Functions" palette
to produce a minimum of two
function entries

4 - Type the two functions to be plotted

Note: the first function listed is plotted
using a blue line, the second one
uses a red line

cos
2
x

sin x22

cos x

sin x
-3 -2 -1 0 1 2 3

2

1

0

-1

-2

x

y 1 - To add more than two functions to plot,
use the "Equation System" option in the
"Functions" palette as above

2 - Click on the "Equation System" cell,
and drag down corner of cell adding as
many placeholders as you want.

3 - Type the functions to be plotted, one at
a time, clicking outside of the graph after
you enter each one of them (this will allow
you to see each function plota as they
are added to the graph)

Notes:
1 - As you add functions to plot, SMath Studio

uses the following colors for the plots:

1 - blue 2 - red
3 - black 4 - magenta, etc.

2 - In this example the graph has been zoomed
using the approach described above

Plotting a function using vectors: Vectors of x and y data are created using ranges,
example:

, ..
20
π

π ππx Create x vector as follows
Type: x : range - p cntl-G , p cntl-G ,

- p cntl-G + p cntl-G / 20

length xn
Calculate the length of vector = n

41n

Fill out y vector using a for loop. Click "for"
in the "Programming" palette, then use:
range 1 , n

Use sub-indices, e.g., y [ k ... etc.

for

sin kx2
2

sin kxky

..n1k
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augment , yxM Form augmented matrix M with vectors x and y,
place M in graph as a function name:

M
-2 0 2

1.5

1

0.5

0

-0.5

x

y

< --- The graph was zoomed in and the axes
moved by using the following procedures:

1 - To zoom x-axis only: click on "Scale" in
the "Plot" palette, hold the "Control" key,
and use the mouse wheel

2 - To zoom y-axis only: click on "Scale" in
the "Plot" paletted, hold the "Shift" key
and use the mouse wheel

3 - To move axes, drag mouse across graph window

Using points or lines for a plot:

M
-4 -2 0 2 4

2

1.5

1

0.5

0

-0.5

-1

x

y
Using the sparse data in matrix M we reproduce
the graph above, but then we selected the
"Graph by points" option in the "Plot" palette
to produce the graph shown to the left.

You can click the option "Graph by lines"
option in the "Plot" palette to return to
the default graph format of continuous lines.

Matrices can be used for plotting parametric plots:

, ..
50
π

π ππt Define the vector of the parameter t

length tn Determine length of vector t = n

for

cos kt22ky

sin kt3kx
..n1k

Calculate vectors of x = x(t) and
y = y(t)

Produce matrix of (x,y) and plot it
augment , yxM
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M
-1 -0.5 0 0.5 1

2

1

0

-1

-2

x

y

M
-1 -0.5 0 0.5 1

2

1

0

-1

-2

x

y

1 - Using "Plot by Lines" option
in the "Plot" palette

2 - Using "Plot by Lines" option
in the "Plot" palette

Polar plots can be produced using vectors and matrices:

, ..
50
π

π20θ Generate vector of θ between 0 and 2π

length θn Determine lenght of vector θ

for
sin kθ212kr

..n1k Generate values of r = f(θ)

for

sin kθkrkyy

cos kθkrkxx
..n1k

Generate coordinates:

x = r cos(θ)
y = r sin(θ)

augment , yyxxP Produce matrix of (x,y) and plot it

P
-4 -2 0 2 4

6

5

4

3

2

1

0

-1

x

y

P
-4 -2 0 2 4

6

5

4

3

2

1

0

-1

x

y

1 - Using "Plot by Lines" option
in the "Plot" palette

2 - Using "Plot by Lines" option
in the "Plot" palette
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Using graphs in solving equations:

In this example we seek the solution(s) for the equation:

5x2
3

x1
2

x

A solution can be found by determining the intersection of the functions:

1
2

xf x 5x2
3

xg x

Using graphics and zooming the intersection we estimate the solution to be close to
x = 1.80

g x

f x
-4 -2 0 2 4

16

12

8

4

0

-4

x

y

g x

f x
1.625 1.6875 1.75 1.8125 1.875

4.375

4.25

4.125

4

3.875

1.776solve , x5x2
3

x1
2

xThe exact solution can be found using:

Three-dimensionalgraphs - surfaces:

yx

x
y

z

0 22

2

44

4

6
6

6

yx

x

y

z

02
2

2

4

4

4

6

6

6

8

8

8

Use the option "3D" in the "Functions" palette,
and enter the function f(x,y) in the place-
holder. The result is a 3D surface, in this
case, a plane. The original plot is shown
above.

Use the "Rotate" option in the "Plot" palette
to change the surface view.
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yx

x

y

z

0 2

2

2
4

4

4

6

6

6

8

8

8

yx

x

y

z

0 2

2

2
4

4

4

6

6

6

8

8

8

This figure uses the option "Graph by
Lines" in the "Plot" palette (default).

This figure uses the option "Graph by
Points" in the "Plot" palette.

yx

x

y

z

0 22

2

4
4

4

6

6

6

y2x

x
y

z

0 99

9

18
18

18

27
27

27

Use the "Move" option in the "Plot" palette
to move the location of the origin in the
graphics window.

Use the "Scale" option in the "Plot" palette,
click on the graph, and drag the mouse over
it to zoom in or out.

Note: Use the "Refresh" option in the "Plot" menu to recover the original version of any plot.
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The following examples use more complex surfaces:

sin x

x

y

z

0 22

2

4
4

4

6
6

6

2
y

2
x5

x
y

z

0 22

2

44

4

6
6

6

yx

x

y

z

02
2

2

4

4

4

6

6

6

yx
yx

x

y

z

022

2

4
4

4

6

6

6

8

8

8

The type of 3D graphs of surfaces produced by SMath Studio are referred to as wireframe plots.

The following examples show more than one surface plot together in 3D:

yx
yx

x
y

z

02 2

2

4 4

4

6 6

6

8
8
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y2x
yx
yx
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y

z

0 2
2
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6
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8

8
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2
y

2
x

2
y

2
x5

x
y

z

0 33

3

6
6

6

9
9

9

sin y

sin x

x

y

z

0 2
2

2

4

4

4

6

6

6

8

8

8

Drawing a space curve in 3D: A space curve is defined by a matrix of three columns
corresponding to coordinates x, y, and z of the curve.

, ..0.1 100t Create a vector t with values of the parameter that
will produce x = x(t), y = y(t), and z = z(t).

length tn Determine the length of vector t

101n

for

2
kt

kz

cos ktky

sin ktkx
..n1k Generate vectors x, y, and z using a "for" loop

augment , , zyxM
Build matrix M with coordinates (x,y,z)

M

x
y

z

0 22

2

44

4

6
6

6

Plot matrix M in a 3D plot
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Drawing a surface and a space curve: Use the "Equation System"
option in the "Plot" palette,
and enter the equation of the
surface (e.g., x+y) and the
matrix that represents the
space curve (e.g., M)

M
yx

x

y

z

0 2

2

2
4

4

4

6

6

6

8

8

8

Plotting 2 space curves: In this example two straight lines in 3D are
produced by using linear parametric equations.

, ..1.9 22t Vector t is the parameter, and the coordinates
of the two curves are given by (x1,y1,z1) and
(x2,y2,z2). These lines are represented by the
matrices P and Q, respectively.

length tn

40n

for

kt81kz1
kt41ky1

kt51kx1
..n1k for

ktkz2
kt1ky2
kt31kx2

..n1k

augment , , z1y1x1P augment , , z2y2x2Q

P

x
y

z

0 22

2

44

4

6
6

6

Q

x
y

z

0 22

2

44

4

6
6

6

Individual plots of curves given by matrices P and Q.
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Q
P

x
y

z

0 22

2

44

4

6
6

6

<--- Join plot of
lines given
by matrices
P and Q
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Appendix 2 - Examples of 2D geometric figures in SMath Studio
------------------------------------------------------------

This worksheet illustrates the use of SMath Studio
2D graphs to produce selected regular and irregular
geometric figures.

Straight-line segment:
----------------------

Given the two points, A and B, representing the
extremes of the straight-line segment, plot the
segment.

2
5

A
10
3

B* Extreme points:

* Generate matrix of points:

1A1B
2A2B

m* Slope: 1.5m

* Intercept:
1Am2Ab 5.5b

* Number of points: 5n

n
1A1B

Δx* Increment: 1.6Δx

* x-series: , ..Δx1A 1B1AxS

* y-series:
for

bkxSmkyS
.. 1n1k

* Matrix of points: augment , ySxSMS

MS
-16 -8 0 8 16

12

8

4

0

-4

-8

12

x

y
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BA
2
1

M
4
1

M* Mid-point:

m
1

mP* Normal slope: 0.6667mP

* Normal intercept:
1MmP2MbP 3.3333bP

n
2A2B

ΔxP* Normal increment: 2.4ΔxP

* Normal x series: , ..Δx2A 2B2AxP

* Normal y-series:
for

bPkxSmPkyP
.. 1n1k

* Matrix of points (normal): augment , yPxSMP

MP
MS

-16 -8 0 8 16

12

8

4

0

-4

-8

12

x

y

Circle:
-------

Given the center, C, and radius, r, of a circle,
plot the circle.

5
3

C* Center: * Radius: 12.5r

* Generate matrix of data: 150n

n
π2

Δθ 0.0419Δθ

for

sin Δθkr2C1kyC

cos Δθkr1C1kxC
..n0k

augment , yCxCMC
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MC
-24 -16 -8 0 8 16
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Regular polygon of n sides:
--------------------------

Given the number of sides, n, the center of the circums-
cribed circle, C, and its radius, plot the regular polygon
of n sides. This example shows a regular pentagon.

* Number of sides: 5n

2
3

C* Center of polygon:

* Radius of circums-
cribed circle:

12r

6
π

θ0* Initial angle:

n
π2

Δθ* Incremental angle: 1.2566Δθ

for

sin Δθkθ0r2C1kyPol

cos Δθkθ0r1C1kxPol
..n0k

* Generate matrix
of points:

augment , yPolxPolMPol

MPol
-16 -8 0 8 16

8
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y
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Calculating the area and perimeter of the regular polygon:
---------------------------------------------------------

The matrices representing the vertices of a polygon,
whether regular or not, include an extra repetition
of the first vertex:

413.3923
10.029611.9177
12.96251.8808
0.74578.9343
9.73780.5051

413.3923

MPol

With such a matrix available, the area and perimeter of the
polygon are calculated as follows.

MPolM
1rows Mn 5n

0Area
0Perim

for

AreaArea

eval d2PerimPerim

eval
2

2kM21kMd2d2

eval
2

1kM11kMd2

eval 2kM11kM
2
1

AreaArea

eval 21kM1kM
2
1

AreaArea

..n1k

MPol
-8 0 8 16

8

4

0

-4

-8

-12

-16

x

y

342.3803Area 70.5342Perim

-----------------------------------------------------------------------
Irregular polygon:
------------------

Enter the (x,y) coordinates of the n polygon vertices in
a nx2 matrix, e.g.,

52
31
17
11
70
31
25

MI

Typically, the initial point needs to be repeated for
the polygon to be completed. This is accomplished by
using:

T

augment ,
T

row , 1MI
T

MIMN
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25
52
31
17
11
70
31
25

MN

MN
-8 -4 0 4 8

8

6

4

2

0

-2

-4

x

y

Calculating the area and perimeter of the irregular polygon:
-----------------------------------------------------------

25
52
31
17
11
70
31
25

MN

As with the case of the
regular polygon, the
matrix representing the
vertices of the irregular
polygon include an extra
repetition of the first
vertex:

With such a matrix available, the area and perimeter of the
polygon is calculated as follows.

Calculating area and perimeter for MN:

MNM
1rows Mn 7n

0Area
0Perim

for

AreaArea

eval d2PerimPerim

eval
2

2kM21kMd2d2

eval
2

1kM11kMd2

eval 2kM11kM
2
1

AreaArea

eval 21kM1kM
2
1

AreaArea

..n1k

MN
-8 -4 0 4 8

6

4

2

0

-2

-4

-6

x

y

7.5Area 38.7516Perim

----------------------------------------------------------------------
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Appendix 3 - The Newton-Raphson method for solving equations
------------------------------------------------------------
In this appendix we present examples of the Newton-Raphson method.

1 - The Newton-Raphson for solving single equations:
---------------------------------------------------

The Newton-Raphson method used for solving an equation of the form

0f x

requires the knowledge of the derivative f'(x). This can be easily
accomplished in SMath Studio using the "Derivative" option in the
"Functions" palette:

d
d x

f xfp x

Given an initial guess of the solution,
0xx , the solution can

be approximated by the iterative calculation:

f' kx

f kx

kx1kx

for 0k ,1, ...

The iteration continues until either the solution converges, i.e.,

εf 1kx , or a certain large number of iterations are performed

without convergence, i.e.,
maxnk

05x2
2

xExample:
--------

Solve the equation:

Solution:
---------

A graph of the function can help us find where the
solutions may be located:

5x2
2

xf xDefine the function:

Produce a graph of f(x):

f x
-4 -2 0 2 4 6

24

16

8

0

-8

x

y
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The graph shows solutions near x = -2 and x = 3. We can
implement the solution using the Newton-Raphson method
as follows:

d
d x

f xfp x x12fp x

6
101.0εParameters of the solution are: 100nmax

First solution:
Starting with a guess of 2.5xG
we find a solution by using the following iterative procedure:

0k

while

xGp1xG
1kk

fp xG
f xG

xGxGp1

εf xGnmaxk

1.4495xG This is the solution found

4k After this many iterations

11
102.1427f xG The function at the solution point

Second solution:
Starting with a guess of 4.2xG
we find a solution by using the following iterative procedure:

0k

while

xGp1xG
1kk

fp xG
f xG

xGxGp1

εf xGnmaxk

3.4495xG This is the solution found

4k After this many iterations

13
102.2529f xG The function at the solution point

2 - Solution to equations with function "solve":
-----------------------------------------------

Most equations can be solved using function "solve" in SMath
Studio. For the present case we'll have:

3.4495
1.4495

solve , x0f x

Alternatively, you can use:

3.4495
1.4495

solve , x05x2
2

x
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3 - The Newton-Raphson method for a system of equations:
-------------------------------------------------------

A system of n equations in n unknowns can be represented as:

0f1 , ..2x nx1x

0f2 , ..2x nx1x

...

0fn , ..2x nx1x

or simply, 0f x , with

fn x
.

f2 x

f1 x

fn , ..2x nx1x

.

f2 , ..2x nx1x

f1 , ..2x nx1x

f x

The variable x is defined as the vector:

nx
.
2x
1x

x

We can provide an initial guess for the solution,
0x , and

proceed with an iterative process defined by the formula:

f kx
1

J kxkx1kx

J kxfor 0k ,1,... In this formula, , is the Jacobian
matrix of the function defined as [to be 100% correct the
derivatives in this matrix should be partial derivatives]:

ndx
ndy

.
2dx
ndy

1dx
ndy

....
ndx
2dy

.
2dx
2dy

1dx
2dy

ndx
1dy

.
2dx
1dy

1dx
1dy

J kx

Example:
--------

How to calculate the Jacobian matrix of a system of three
equations. Given the system of three equations:
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14
3

3x
2

2x
2

1x

63x2x1x

63x2x1x

f x

This is obvious, but could
useful for larger functions:

length f xn

3n

The following nested "for" loops calculate the elements of
the jacobian matrix as the elements "jac[i,j]":

for
for

d
d

jx i
f xjijac

..n1j
..n1i

The following definition creates the function "Jacobi" that
represents the Jacobian matrix of the function f(x) shown
earlier:

jacJacobi x

2
3x32x21x2

2x1x3x1x3x2x
111

Jacobi x

-------------------------------------------------------------------
Note: This approach for calculating the Jacobian matrix of a vector
function was made available by Radovan Omorjan (omorr) in the SMath
Studio wiki page: http://smath.info/wiki/diff.ashx
------------------------------------------------------------------

Generalized Newton-Raphson method for solving a system of equations:
-------------------------------------------------------------------

20
101εThe parameters of the solution are: 100nmax

4
1
5

xGAn initial guess is:

The iterative process for the solution is expressed as:

0k

while

xGp1xG
1kk

f xG
1

Jacobi xGxGxGp1

εmax f xGnmaxk

A solution is found after these many iterations:

12k

Here's a solution: And the function at that point:

1
2
3

xG

14
103.253

14
101.0068

15
103.9328

f xG
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----------------------------------------------------------------
Note: The function representing the system of equations solved
above, namely,

14
3

3x
2

2x
2

1x

63x2x1x

63x2x1x

f x

can be thought of representing the system of equations:

06zyx 6zyx

06zyx or 6zyx

014
2

z
2

y
2

x 14
2

z
2

y
2

x

with the variable substitution: x1x , y2x , and z3x .

----------------------------------------------------------------
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Appendix 4 - The 4th -order Runge-Kutta method for a single ODE
---------------------------------------------------------------

Problem description
-------------------

This worksheet provides two different versions of the 4th-order
Runge-Kutta method for solving a first-order ordinary differential
equation (ODE) of the form:

f , yx
d
d x

y

subject to the initial condition: ysy xs

The solution will be provided in the range: xs ≤ x ≤ xe
which will be divided into n subintervals to produce solution
vectors "xsol" and "ysol", as detailed below.

The increment in the x solution vector, Δx,is calculated as:

n
xsxe

Δx

Thus, the solution vector will be calculated using the uniformly-
distributed values: [xs,xs+Δx,xs+2*Δx,...,xs+n*Δx].Using SMath
Studio the x solution vector can be easily created using the
command:

xsol: range(xs,xe,xs+Δx)

The y solution vector will be calculated using the Runge-Kutta
algorithm, which is detailed below. The first value in the
y solution will be the initial condition ys, i.e.,

ys1ysol

Iterative process for solution - version 1
------------------------------------------

Next, we start an iterative procedure with the index k varying
between 1 and n, i.e., k = 1, 2, ..., n. To illustrate the
calculations involved, we illustrate the k-th interval in the
following figure:
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In this figure the lower x limit of the interval is x[k],
which is represented by x0 in the calculations. On the
other hand, the upper x limit of the interval is x[k+1],
which is represented by x1. The corresponding values of
the solution are y0 = y(x0) and y1 = y(x1). The Runge-
Kutta algorithm uses the mid-point (xM,yM) illustrated
also in the figure.

Runge-Kutta calculations - version 1
------------------------------------

The calculations involved in the 4th-order Runge-Kutta
algorithm to calculate y1 = ysol[k+1] are listed below:

Δx
2
1

x0xM f , y0x0ΔxK1

K1
2
1

y0yM f , yMxMΔxK2

K2
2
1

y0yM f , yMxMΔxK3

K3y0y1 f , y1x1ΔxK4

K4K32K22K1
6
1

y01kysol

Solution summary and graph
--------------------------

Once the iterative process has been completed, the
solution will be contained in the column vectors "xsol"
and "ysol". At this point, the user may decide to show
the solution as vectors, or put them together into a
matrix, say,

augment , ysolxsolM

This matrix can be stored in a file, or plotted in a
2D graph to show the solution graphically.
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Example of 4th-order Runge-Kutta solution -version 1
----------------------------------------------------

sin x
dx
dy

Solve the ODE: , subject to the initial

condition: 1y 0 in the interval: 0 ≤ x ≤ 20

using 100 intervals in the solution.

Solution:
---------

First, define the function f(x,y): cos ysin xf , yx

The initial conditions are: 0xs 1ys

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

Create the y solution vector as a zero matrix of n rows and 1
column, and initialize the y solution vector with the initial
condition ys:

matrix , 1nysol ys1ysol

The following "for" loop calculates the Runge-Kutta algorithm
(version 1) to produce the solution:

for

eval K4K32K22K1
6
1

y01kysol

eval f , y1x1ΔxK4

eval 1kxsolx1

eval K3y0y1

eval f , yMxMΔxK3

eval K2
2
1

y0yM

eval f , yMxMΔxK2

eval K1
2
1

y0yM

eval f , y0x0ΔxK1

eval Δx
2
1

x0xM

eval kysoly0

eval kxsolx0
..n1k

The solution is summarized into matrix M and shown as a x-y plot:

augment , ysolxsolM
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M
0 4 8 12 16 20

2

1.5

1

0.5

0 x

y

M
0 4 8 12 16 20

2

1.5

1

0.5

0 x

y

The plot to the left uses the "Graph by lines" option in the "Plot"
palette, while the plot to the right uses the "Graph by points"
option in the "Plot" palette.

Iterative process for solution - version 2
------------------------------------------

The second version of the Runge-Kutta solution divides the k-th
interval into three equal parts are illustrated in the figure
below:

In this figure the lower x limit of the interval is x[k],
which is represented by x0 in the calculations. On the
other hand, the upper x limit of the interval is x[k+1],
which is represented by x1. The corresponding values of
the solution are y0 = y(x0) and y1 = y(x1). The Runge-
Kutta algorithm uses two mid-points (x13,y13) and (x23,
y23) illustrated also in the figure.

Runge-Kutta calculations - version 2
------------------------------------

The calculations involved in the 4th-order Runge-Kutta
algorithm to calculate y1 = ysol[k+1] are listed below:
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Δx
3
1

x0x13 Δx
3
2

x0x23 f , y0x0ΔxK1

K1
3
1

y0y13 f , y13x13ΔxK2

K2
3
1

y13y23 f , y23x23ΔxK3

K3K2K1y0y1 f , y1x1ΔxK4

K4K33K23K1
8
1

y01kysol

Example of 4th-order Runge-Kutta solution -version 2
----------------------------------------------------

sin x
dx
dy

Solve the ODE: , subject to the initial

condition: 1y 0 in the interval: 0 ≤ x ≤ 20

using 100 intervals in the solution.

Solution:
---------

First, define the function f(x,y): cos ysin xf , yx

The initial conditions are: 0xs 1ys

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

Create the y solution vector as a zero matrix of n rows and 1
column, and initialize the y solution vector with the initial
condition ys:

matrix , 1nysol ys1ysol

The following "for" loop calculates the Runge-Kutta algorithm
(version 2) to produce the solution:
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for

eval K4K33K23K1
8
1

y01kysol

eval f , y1x1ΔxK4

eval 1kxsolx1

eval K3K2K1y0y1

eval f , y23x23ΔxK3

eval K2
3
1

y13y23

eval f , y13x13ΔxK2

eval K1
3
1

y0y13

eval f , y0x0ΔxK1

eval Δx
3
2

x0x23

eval Δx
3
1

x0x13

eval kysoly0

eval kxsolx0
..n1k

The solution is summarized into matrix N and shown as a x-y plot:

augment , ysolxsolN

N
0 4 8 12 16 2

2.5

2

1.5

1

0.5

0 x

y

N
0 4 8 12 16 2

2.5

2

1.5

1

0.5

0 x

y

The plot to the left uses the "Graph by lines" option in the "Plot"
palette, while the plot to the right uses the "Graph by points"
option in the "Plot" palette.
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Appendix 5 - The 4th -order Runge-Kutta method for a system of ODEs
-------------------------------------------------------------------

Problem description
-------------------

Consider the case of a system of two first-order ODEs given by:

f1 , yxf1 ,
2y
1y

x
dx
1dy

f2 , yxf2 ,
2y
1y

x
dx
2dy

subject to the initial conditions:

1y1ys
1xs and

2y2ys
2xs

This system of equations can be re-written as a single ODE in
which y and f are column vectors, i.e.,

2y
1y

yf , yx
dx
dy

f2 , yx

f1 , yx
f , yx, with and

ys2
ys1

ysThe initial conditions are given by the vector:

Once the system of equations is written as a single ODE, the
Runge-Kutta algorithms presented for a single ODE can be used
to solve the equation. This illustrated in the following
example.

Example
-------

Solve the system of first-order ODEs:

sin 2ycos 1ysin x
dx
1dy

sin 2ycos x
dx
2dy

Subject to the initial conditions:

1y1 0 and 1y2 0

Solve the ODEs in the interval: 0 ≤ x ≤ 20 using 100 intervals.
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Solution (version 1):
---------------------

First, define the vector function f(x,y):

sin 2ycos x

sin 2ycos 1ysin x
f , yx

1
1

ysThe initial conditions are: 0xs

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

The y-solution vector gets initialized as follows:

ysysol
1
1

ysol

The following "for" loop calculates the Runge-Kutta algorithm
(version 1) to produce the solution:

for

augment , y1ysolysol

eval K4K32K22K1
6
1

y0y1

eval f , y1x1ΔxK4

eval 1kxsolx1

eval K3y0y1

eval f , yMxMΔxK3

eval K2
2
1

y0yM

eval f , yMxMΔxK2

eval K1
2
1

y0yM

eval f , y0x0ΔxK1

eval Δx
2
1

x0xM

eval col , kysoly0

eval kxsolx0
..n1k

After completing the iterative process, the solution is
stored in a row vector called "ysol". This vector can be
transposed to put together the graph of the two solutions
as illustrated here:

T
ysolysol
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augment , col , 1ysolxsolM1

augment , col , 2ysolxsolM2

M2
M1
0 4 8 12 16 20

4

3

2

1

0

-1

x

y

M2
M1
0 4 8 12 16 20

4

3

2

1

0

-1

x

y

The plot to the left uses the "Graph by lines" option in the "Plot"
palette, while the plot to the right uses the "Graph by points"
option in the "Plot" palette.

Solution (version 2):
---------------------

First, define the vector function f(x,y):

sin 2ycos x

sin 2ycos 1ysin x
f , yx

1
1

ysThe initial conditions are: 0xs

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

The y-solution vector gets initialized as follows:

ysysol
1
1

ysol

The following "for" loop calculates the Runge-Kutta algorithm
(version 1) to produce the solution:
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for

augment , y1ysolysol

eval K4K33K23K1
8
1

y0y1

eval f , y1x1ΔxK4

eval 1kxsolx1

eval K3K2K1y0y1

eval f , y23x23ΔxK3

eval K2
3
1

y13y23

eval f , y13x13ΔxK2

eval K1
3
1

y0y13

eval f , y0x0ΔxK1

eval Δx
3
2

x0x23

eval Δx
3
1

x0x13

eval col , kysoly0

eval kxsolx0
..n1k

After completing the iterative process, the solution is
stored in a row vector called "ysol". This vector can be
transposed to put together the graph of the two solutions
as illustrated here:

T
ysolysol

augment , col , 1ysolxsolN1

augment , col , 2ysolxsolN2

N2
N1
0 4 8 12 16 20

4

3

2

1

0 x

y

N2
N1
0 4 8 12 16 20

4

3

2

1

0 x

y

The plot to the left uses the "Graph by lines" option in the "Plot"
palette, while the plot to the right uses the "Graph by points"
option in the "Plot" palette.
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Appendix 6 - The 4th -order Runge-Kutta method for a 2nd order ODE
-----------------------------------------------------------------
By Gilberto E. Urroz, Ph.D., P.E.
January 2010

Problem description
-------------------

Consider the 2nd-order ODE: sin xy3y'yy"

subject to the initial conditions: 1y 0 1y' 0

Variable substitution to form a system of ODEs:
----------------------------------------------

This 2nd-order ODE can be converted into a system of
two 1st-order ODEs by using the following variable
substitution:

y1u y'2u

with initial conditions:

11u and 12u at 0x .

The variable substitution y'2u is equivalent to:

2u
d
d x 1u [Eq. 1]

while the ODE is re-written as: sin xy3y'yy"

or:
sin x

1
u32u1u

d
d x 2u [Eq. 2]

The system of equations [Eq. 1] and [Eq. 2] is transformed
into the vector ODE:

sin x
1

u32u1u

2u
d
d x 2u

1u

or,

2u
1u

uf , ux
d
d x

u , where and

sin x
1

u32u1u

2u

f , ux

1
1

usThe initial conditions are at 0xs

We'll solve the ODEs in the interval: 0 ≤ x ≤ 20 using 100 intervals.

10 May 2010 21:26:49 - RK4-2ndOrderODE.sm

1 / 4



Solution (version 1):
---------------------

First, define the vector function f(x,u):

sin x
1

u32u1u

2u

f , ux

1
1

usThe initial conditions are: 0xs

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

The y-solution vector gets initialized as follows:

ususol
1
1

usol

The following "for" loop calculates the Runge-Kutta algorithm
(version 1) to produce the solution:

for

augment , u1usolusol

eval K4K32K22K1
6
1

u0u1

eval f , u1x1ΔxK4

eval 1kxsolx1

eval K3u0u1

eval f , uMxMΔxK3

eval K2
2
1

u0uM

eval f , uMxMΔxK2

eval K1
2
1

u0uM

eval f , u0x0ΔxK1

eval Δx
2
1

x0xM

eval col , kusolu0

eval kxsolx0
..n1k

After completing the iterative process, the solution is
stored in a row vector called "ysol". This vector can be
transposed to put together the graph of the two solutions
as illustrated here:

T
usolusol
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augment , col , 1usolxsolM1

augment , col , 2usolxsolM2

M2
M1

0 2 4 6 8 10 12 14 16 18 20

3

2

1

0

-1

x

y

The blue line represents u[1]=y while the red line represents
u[2] = dy/dx.

Solution (version 2):
---------------------

First, define the vector function f(x,y):

sin x
1

u32u1u

2u

f , ux

1
1

usThe initial conditions are: 0xs

The end of the solution interval is: 20xe

Use 100 intervals: 100n

Calculate the increment size, Δx:

eval
n
xsxe

Δx 0.2Δx

Create the x solution vector: eval , ..Δxxs xexsxsol

The y-solution vector gets initialized as follows:

ususol
1
1

usol

The following "for" loop calculates the Runge-Kutta algorithm
(version 1) to produce the solution:
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for

augment , u1usolusol

eval K4K33K23K1
8
1

u0u1

eval f , u1x1ΔxK4

eval 1kxsolx1

eval K3K2K1u0u1

eval f , u23x23ΔxK3

eval K2
3
1

u13u23

eval f , u13x13ΔxK2

eval K1
3
1

u0u13

eval f , u0x0ΔxK1

eval Δx
3
2

x0x23

eval Δx
3
1

x0x13

eval col , kusolu0

eval kxsolx0
..n1k

After completing the iterative process, the solution is
stored in a row vector called "ysol". This vector can be
transposed to put together the graph of the two solutions
as illustrated here:

T
usolusol

augment , col , 1usolxsolN1

augment , col , 2usolxsolN2

N2
N1
-2 0 2 4 6 8 10 12 14 16 18 20

3

2

1

0

-1

x

y

The blue line represents u[1]=y while the red line represents
u[2] = dy/dx.
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Appendix 7 - Finding eigenvalues and eigenvectors of a matrix
------------------------------------------------------------

Given a matrix, say the 4x4 matrix symmetric matrix A:

4862
8324
6222
2421

A
The following program calculates the
coefficients of the characteristic
equation: 0IλA

The resulting equation is the polynomial:

2
λ3pλ2p1p 0

n
λ1np

1n
λnp+ ... +

which is solved uising function "polyroots."

The programming steps following the line with function
"polyroots," below, are used to calculate a matrix, V,
whose columns are the eigenvectors of the matrix A.

The SMath Studio program that calculates eigenvalues and
eigenvectors of A is the following:

submatrix , , , , n21nn1VV

for

augment , xλVV

norme xλ
xλ

xλ

col , jVxλ
..n1j

stack , VbVV

for
1j1Vb
..n1j

matrix , n1Vb

submatrix , , , , n11n1VV

for

augment , VxλV
bλ

1
Aλmxλ

submatrix , , , , nn1n1Aλbλ

submatrix , , , , 1n11n1AλAλm

IjλAAλ
..n1j

matrix , 11nV

polyroots pλ

p
n

1p

for

1jn
tr B

1jp

I11jpBAB
, ..2n 11nj

tr B1np
AB

1.011np

identity nI

matrix , 1np

rows An
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Coefficients: Eigenvalues: Eigenvectors:

1
10
93
530
1300

p

13.4505
7.8257
6.3272
1.952

λ

0.08230.26620.64460.7119
0.40760.3740.56930.6082
0.34460.75690.51030.2188
0.84160.46510.00370.2746

V

Extracting the individual eigenvectors:

col , 1Vx1 col , 2Vx2 col , 3Vx3 col , 4Vx4

0.7119
0.6082
0.2188
0.2746

x1

0.6446
0.5693
0.5103
0.0037

x2

0.2662
0.374
0.7569
0.4651

x3

0.0823
0.4076
0.3446
0.8416

x4

Checking that the eigenvectors are unit and orthogonal:

16
102.8843x2

T
x1 1norme x1

14
102.2924x3

T
x1 1norme x2

14
103.5213x4

T
x1

1norme x3

1norme x4
14

101.0401x3
T

x2

14
108.4221x4

T
x2

14
102.6966x4

T
x3
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